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Preparation of Papers for AIAA Technical Conferences 

First A. Author1 and Second B. Author, Jr.2

Business or Academic Affiliation 1, City, State, Zip Code 
 

Third Author3

Business or Academic Affiliation 2, City, Province, Zip Code, Country 
 

and 

Fourth C. Author4

Business or Academic Affiliation 2, City, State, Zip Code 
 

These instructions give you guidelines for preparing papers for AIAA Technical 
Conferences. Use this document as a template if you are using Microsoft Word 2000-XP or 
later, or Word for Mac OS X. Otherwise, use this document as an instruction set. Define all 
symbols used in the abstract. Do not cite references in the abstract. The footnote on the first 
page should list the Job Title and AIAA Member Grade for each author. 

Nomenclature 
A = amplitude of oscillation 
a = cylinder diameter 
Cp = pressure coefficient 
Cx = force coefficient in the x direction 
Cy = force coefficient in the y direction 
c = chord 
dt = time step 
Fx = X component of the resultant pressure force acting on the vehicle 
Fy = Y component of the resultant pressure force acting on the vehicle 
f, g = generic functions 
h = height 
i = time index during navigation 
j = waypoint index 
K = trailing-edge (TE) nondimensional angular deflection rate 

I. Introduction 
HIS document is a template for Microsoft Word version 2000-XP, Microsoft Word version 2003, or Word for 
Mac OS X. If you are reading a hardcopy or PDF version of this document, please download the electronic 

template file, Papers_Template.dot, from the AIAA Meeting Papers Information Page ((“Conferences & 
Events>Submit/Edit a Paper>Author Kit and Meeting Papers Template” from the AIAA Web site) so you can use it 
to prepare your manuscript. 

Authors using Microsoft Word will first need to save the Papers_Template.dot file in the “Templates” directory 
of their hard drive. To do so, simply open the Papers_Template.dot file and then click “File>Save As:” to save the 
template. (Note: Windows users will need to indicate “Save as Type>Document Template (*.dot)” when asked in 
the dialogue box; Mac users should save the file in the “My Templates” directory.) To create a new document using 
this template, use the command ”File>New>From Template” (Windows) or “File>Project Gallery>My Templates” 
                                                           
1 Insert Job Title, Department Name, Address/Mail Stop, and AIAA Member Grade for first author. 
2 Insert Job Title, Department Name, Address/Mail Stop, and AIAA Member Grade for second author. 
3 Insert Job Title, Department Name, Address/Mail Stop, and AIAA Member Grade for third author. 
4 Insert Job Title, Department Name, Address/Mail Stop, and AIAA Member Grade for fourth author (etc). 

T 
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(Mac). The new document that opens will be titled “Papers_Template.doc.” To create your formatted manuscript, 
type your own text over sections of Papers_Template.doc, or cut and paste from another document and then use the 
available markup styles. The pull-down menu is at the left of the Formatting Toolbar at the top of your Word 
window (for example, the style at this point in the document is “Text”). Highlight a section that you want to 
designate with a certain style, then select the appropriate style name from the pull-down style menu. The style will 
automatically adjust your fonts and line spacing. Do not change the font sizes, line spacing, or margins. Use italics 
for emphasis; do not underline. 
 

II. Procedure for Paper Submission 
All manuscripts are to be submitted electronically to the ScholarOne Abstracts site created for each conference. 

The manuscript upload will be enabled several weeks after acceptance notices have been sent.  Presenting authors of 
accepted papers will receive an email with instructions when manuscript submission is open.  It is important that 
presenting authors keep their email addresses up-to-date so they do not miss this notice.  

Before completing manuscript  submission, submitters must also select the copyright statement that will appear 
on the paper, and complete other acknowledgments.  It is also necessary to click both the “Accept” and “Save” 
buttons to complete a submission.   No confirmation email will be sent upon completion of the manuscript 
submission.  To confirm successful submission, submitters should reopen their manuscript submission pages and 
check the status of their submissions.  A completed submission will have a status of “Accepted – Complete.” 

All files must be in pdf format.  Please be sure that all security settings are removed from the pdf file before 
uploading to ensure proper processing of your manuscript file. 

III. General Guidelines 
The following section outlines general (nonformatting) guidelines to follow, drawn from the original AIAA 

Manuscript Preparation Kit. These guidelines are applicable to all authors (except as noted), and include information 
on the policies and practices relevant to the publication of your manuscript. 

A. Publication by AIAA 
Your manuscript cannot be published by AIAA if: 
1) It has been published previously or 
2) An appropriate copyright statement has not yet been selected. 

B. Paper Review and Visa Considerations 
It is the responsibility of the author to obtain any required government or company reviews for their papers in 

advance of publication. Start early to determine if the reviews are required; this process can take several weeks. 
If you plan to attend an AIAA technical conference or professional development course held in the United States 

and you require a visa for travel, it is incumbent upon you to apply for a visa with the U.S. embassy (consular 
division) or consulate with ample time for processing.  To avoid bureaucratic problems, AIAA strongly suggests that 
you submit your formal application to U.S. authorities a minimum of 120 days in advance of the date of anticipated 
travel. 

Prospective conference and course attendees requiring a visa to travel to the United States should first contact 
AIAA to request an official letter of invitation. This letter and a copy of the conference call for papers should be 
presented along with the required documentation to the U.S. consular officials as part of the formal application 
process.  AIAA cannot directly intervene with the U.S. Department of State, consular offices, or embassies on behalf 
of individuals applying for visas. A letter of invitation can be requested at 
https://www.aiaa.org/Secondary.aspx?id=6258  or you may contact AIAA Customer Service at custserv@aiaa.org 
for more information. 

C. Control ID Number vs Paper Number 
Your paper was assigned a control ID number at the time you submitted your abstract. It is critical that you 

reference the tracking number and conference name when contacting AIAA regarding your submission. The control 
ID number is not the final AIAA paper number. The paper number, which appears in the format AIAA-201N-
NNNN, will be used to refer to your paper in the program and in any publication format. It will not be assigned until 
shortly before the conference.  Do not include a paper number anywhere on your paper, as this number will be 
stamped automatically in the top right corner of your paper at the time of processing. 
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D. Copyright 
Before AIAA can print or publish any paper, the copyright information must be completed on our Web site. 

Failure to complete the form correctly could result in your paper not being published. The following fields must be 
completed: 

1) Clearance Statement 
2) Non-Infringement Statement 
3) Publication Status Statement 
4) One Copyright Assignment Statement (Select either A, B, C, or D) 
Be sure to read the copyright statements carefully. If you are not sure which copyright statement to use, contact 

your legal department; AIAA cannot help you determine which statement to use. A hard copy of the form is found in 
the Author Kit for your reference. As you will be completing this form online, you do not need to fill out the hard-
copy form. Do not include a copyright statement anywhere on your paper, and do not upload a copyright form with 
your paper. The correct statement will be stamped automatically at the time of processing. 

E. Submission Deadlines 
Manuscripts will be accepted for upload to the system from the receipt of the email invitation until the deadline 

set for the conference. You will be notified of the specific manuscript submission deadline in your acceptance letter, 
and the deadline will also be listed on the conference web page at AIAA.  Please do not upload a draft version of 
your manuscript with the intent to upload a final version later.    Please review your manuscript very carefully 
before completing your submission to ensure that your paper is complete and final in all respects.  Once the 
manuscript deadline has passed you will be locked out of the manuscript site so it is critical that you upload a 
final, carefully proofed document.  

On-line conference proceedings will be made accessible to attendees who have registered for the "full 
conference" when the conference opens.  No updates to the proceedings will be made during the conference.  
Revision requests must be received at revisions@aiaa.org within 7 business days of the close of the conference.  The 
proceedings will then be updated  shortly after that date.   

To ensure conference quality, session chairs will enforce a "no paper, no podium" rule. This policy states that if 
your manuscript is not uploaded to the ScholarOne Abstracts site prior to the conference, you will not be allowed to 
present the paper at the conference.  

F. Oversize Papers and Color Illustrations 
As of 2006, all papers presented at AIAA events are published in an electronic-only (online and/or CD-ROM) 

format. Papers published in either of these electronic formats will be reproduced in color automatically. There is no 
“oversize paper” or color illustration charge associated with published AIAA papers. 

IV. Detailed Formatting Instructions 
The styles and formats for the AIAA Papers Template have been incorporated into the structure of this 

document. If you are using Microsoft Word 2000 or later, please use this template to prepare your manuscript. If you 
are reading a hardcopy or PDF version of this document, please download the electronic template file, 
Papers_Template.dot, from the AIAA Meeting Papers Information Page (“Conferences & Events>Submit/Edit a 
Paper>Author Kit and Meeting Papers Template” from the AIAA Web site). A LaTeX style and sample files are 
also available from the same Web page if you prefer to use LaTeX. Regardless of which program you use to prepare 
your manuscript, please use the formatting instructions contained in this document as a guide. 

If you are using the Papers_Template.dot file to prepare your manuscript, you can simply type your own text 
over sections of this document, or cut and paste from another document and use the available markup styles. The 
pull-down menu on the left-hand side of the Formatting Toolbar at the top of your Word window contains all the 
styles you will need to format your document. Highlight a section that you want to designate with a certain style and 
select the appropriate style name from the pull-down style menu. The style will automatically adjust your fonts, tabs, 
and line spacing as appropriate. Do not change the font sizes, line spacing, or margins. Use italics for emphasis; do 
not underline. Use the “Page Layout” feature from the “View” menu bar (View>Page Layout) to see the most 
accurate representation of how your final paper will appear.  

A. Document Text 
The default font for AIAA papers is Times New Roman, 10-point size. In the electronic template, use the “Text” 

style from the pull-down menu to format all primary text for your manuscript. The first line of every paragraph 

mailto:revisions@aiaa.org�
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should be indented, and all lines should be single-spaced. Default margins are 1” on all sides. In the electronic 
version of this template, all margins and other formatting is preset. There should be no additional lines between 
paragraphs. 

Extended quotes, such as this example, are to be used when material being cited is longer than a few sentences, or the 
standard quotation format is not practical. In this Word template, the appropriate style is “Extended Quote” from the 
drop-down menu. Extended quotes are to be in Times New Roman, 9-point font, indented 0.4” and full justified. 

NOTE: If you are using the electronic template (Papers_Template.dot) to format your manuscript, the required 
spacing and formatting will be applied automatically, simply by using the appropriate style designation from the 
pull-down menu. 

B. Headings 
The title of your paper should be typed in bold, 18-point type, with capital and lower-case letters, and centered at 

the top of the page. The names of the authors, business or academic affiliation, city, and state/province should 
follow on separate lines below the title. The names of authors with the same affiliation can be listed on the same line 
above their collective affiliation information. Author names are centered, and affiliations are centered and in italic 
type. The affiliation line for each author is to include that author’s city, state, and zip/postal code (or city, province, 
zip/postal code and country, as appropriate). The first footnote (lower left-hand side) is to contain the job title and 
department name, street address/mail stop, and AIAA member grade for each author. 

Major headings (“Heading 1” in the template style list) are bold 11-point font, centered, and numbered with 
Roman numerals. 

Subheadings (“Heading 2” in the template style list) are bold, flush left, and numbered with capital letters. 
Sub-Subheadings (“Heading 3” in the template style list) are italic, flush left, and numbered (1. 2. 3. etc.) 

C. Abstract 
The abstract should appear at the beginning of your paper. It should be one paragraph long (not an introduction) 

and complete in itself (no reference numbers). It should indicate subjects dealt with in the paper and state the 
objectives of the investigation. Newly observed facts and conclusions of the experiment or argument discussed in 
the paper must be stated in summary form; readers should not have to read the paper to understand the abstract. The 
abstract should be bold, indented 3 picas (1/2”) on each side, and separated from the rest of the document by two 
blank lines. 

D. Footnotes and References 
Footnotes, where they appear, should be placed above the 1” margin at the bottom of the page. To insert 

footnotes into the template, use the Insert>Footnote feature from the main menu as necessary. Footnotes are 
formatted automatically in the template, but if another medium is used, should appear in superscript as symbols in 
the sequence, *, †, ‡, §, ¶, #, **. ††, ‡‡, §§, etc. 

List and number all bibliographical references at the end of the paper. Corresponding superscript numbers are 
used to cite references in the text,1 unless the citation is an integral part of the sentence (e.g., “It is shown in Ref. 2 
that…”) or follows a mathematical expression: “A2 + B = C (Ref. 3).” For multiple citations, separate reference 
numbers with commas,4,5 or use a dash to show a range.6-8 Reference citations in the text should be in numerical 
order. 

In the reference list, give all authors’ names; do not use “et al.” unless there are six authors or more. Papers that 
have not been published should be cited as “unpublished”; papers that have been submitted or accepted for 
publication should be cited as “submitted for publication.” Private communications and personal Web sites should 
appear as footnotes rather than in the reference list. 

References should be cited according to the standard publication reference style (for examples, see the 
“References” section of this template). As a rule, all words are capitalized except for articles, conjunctions, and 
prepositions of four letters or fewer. Names and locations of publishers should be listed; month and year should be 
included for reports and papers. For papers published in translation journals, please give the English citation first, 
followed by the original foreign language citation. 

E. Images, Figures, and Tables 
All artwork, captions, figures, graphs, and tables will be reproduced exactly as submitted. Be sure to position any 

figures, tables, graphs, or pictures as you want them printed. AIAA will not be responsible for incorporating your 
figures, tables, etc. (Company logos and identification numbers are not permitted on your illustrations.) 
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Tables and figures of all types should be inserted into text boxes (or frames, if text boxes are not practical) as 
illustrated here. Text boxes should have no background and no outlines. Both the illustration itself and the caption 
should be included in the same box. In the electronic template, use the “Figure” style from the pull-down formatting 
menu to type caption text. Captions are bold and justified, with a period and a single tab (no hyphen or other 
character) between the figure number and figure description.  

Place figure captions below all figures; place table titles above the tables. If your figure has multiple parts, 
include the labels “a),” “b),” etc. below and to the left of each part, above the figure caption. Please verify that the 
figures and tables you mention in the text actually exist. Please do not include captions as part of the figures, and do 
not put captions in separate text boxes linked to the figures. When citing a figure in the text, use the abbreviation 
“Fig.” except at the beginning of a sentence. Do not abbreviate “Table.” Number each different type of illustration 
(i.e., figures, tables, images) sequentially with relation to other illustrations of the same type. 

Figure axis labels are often a source of confusion. Use words rather than symbols. As in the example to the right, 
write the quantity “Magnetization” rather than just “M.” Do not enclose units in parenthesis, but rather separate 
them from the preceding text by commas. Do not label axes only with units. As in Fig. 1, for example, write 
“Magnetization, A/m” or “Magnetization, 
A ⋅m−1,” not just “A/m.” Do not label axes 
with a ratio of quantities and units. For 
example, write “Temperature, K,” not 
“Temperature/K.” 

Multipliers can be especially confusing. 
Write “Magnetization, kA/m” or 
“Magnetization, 103 A/m.” Do not write 
“Magnetization (A/m) x 1000” because the 
reader would not then know whether the 
top axis label in Fig. 1 meant 16000 A/m or 
0.016 A/m. Figure labels must be legible, 
approximately 8-12 point type. 

F. Equations, Numbers, Symbols, and 
Abbreviations 

Equations are centered and numbered 
consecutively, with equation numbers in 
parentheses flush right, as in Eq. (1). Insert 
a blank line on either side of the equation. 
First use the equation editor to create the 
equation. If you are using Microsoft Word, 
use either the Microsoft Equation Editor or 
the MathType add-on (http://www.mathtype.com) for equations in your paper, use the function 
(Insert>Object>Create New>Microsoft Equation or MathType Equation) to insert it into the document. Please note 
that “Float over text” should not be selected. To insert the equation into the document: 

1) Select the “Equation” style from the pull-down formatting menu and hit “tab” once. 
2) Insert the equation, hit “tab” again, 
3) Enter the equation number in parentheses. 

 A sample equation is included here, formatted using the preceding instructions. To make your equation more 
compact, you can use the solidus (/), the exp function, or appropriate exponents.  Use parentheses to avoid 
ambiguities in denominators. 

  (1) 

Be sure that the symbols in your equation are defined before the equation appears, or immediately following. 
Italicize symbols (T might refer to temperature, but T is the unit tesla). Refer to “Eq. (1),” not “(1)” or “equation (1)” 
except at the beginning of a sentence: “Equation (1) is…” Equations can be labeled other than “Eq.” should they 

 
Figure 1. Magnetization as a function of applied field. Figure 
captions should be bold and justified, with a period and a single tab 
(no hyphen or other character) between the figure number and the 
figure description. 
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represent inequalities, matrices, or boundary conditions. If what is represented is really more than one equation, the 
abbreviation “Eqs.” can be used. 

Define abbreviations and acronyms the first time they are used in the text, even after they have already been 
defined in the abstract. Very common abbreviations such as AIAA, SI, ac, and dc do not have to be defined. 
Abbreviations that incorporate periods should not have spaces: write “P.R.,” not “P. R.” Delete periods between 
initials if the abbreviation has three or more initials; e.g., U.N. but ESA. Do not use abbreviations in the title unless 
they are unavoidable (for instance, “AIAA” in the title of this article). 

G. General Grammar and Preferred Usage 
Use only one space after periods or colons. Hyphenate complex modifiers: “zero-field-cooled magnetization.” 

Avoid dangling participles, such as, “Using Eq. (1), the potential was calculated.” [It is not clear who or what used 
Eq. (1).] Write instead “The potential was calculated using Eq. (1),” or “Using Eq. (1), we calculated the potential.” 

Use a zero before decimal points: “0.25,” not “.25.” Use “cm2,” not “cc.” Indicate sample dimensions as “0.1 cm 
x 0.2 cm,” not “0.1 x 0.2 cm2.” The preferred abbreviation for “seconds” is “s,” not “sec.” Do not mix complete 
spellings and abbreviations of units: use “Wb/m2” or “webers per square meter,” not “webers/m2.” When expressing 
a range of values, write “7 to 9” or “7-9,” not “7~9.” 

A parenthetical statement at the end of a sentence is punctuated outside of the closing parenthesis (like this). (A 
parenthetical sentence is punctuated within parenthesis.) In American English, periods and commas are placed 
within quotation marks, like “this period.” Other punctuation is “outside”! Avoid contractions; for example, write 
“do not” instead of “don’t.” The serial comma is preferred: “A, B, and C” instead of “A, B and C.” 

If you wish, you may write in the first person singular or plural and use the active voice (“I observed that…” or 
“We observed that…” instead of “It was observed that…”). Remember to check spelling. If your native language is 
not English, please ask a native English-speaking colleague to proofread your paper. 

The word “data” is plural, not singular (i.e., “data are,” not “data is”). The subscript for the permeability of 
vacuum µ0 is zero, not a lowercase letter “o.” The term for residual magnetization is “remanence”; the adjective is 
“remanent”; do not write “remnance” or “remnant.” The word “micrometer” is preferred over “micron” when 
spelling out this unit of measure. A graph within a graph is an “inset,” not an “insert.” The word “alternatively” is 
preferred to the word “alternately” (unless you really mean something that alternates). Use the word “whereas” 
instead of “while” (unless you are referring to simultaneous events). Do not use the word “essentially” to mean 
“approximately” or “effectively.” Do not use the word “issue” as a euphemism for “problem.” When compositions 
are not specified, separate chemical symbols by en-dashes; for example, “NiMn” indicates the intermetallic 
compound Ni0.5Mn0.5 whereas “Ni–Mn” indicates an alloy of some composition NixMn1-x. 

Be aware of the different meanings of the homophones “affect” (usually a verb) and “effect” (usually a noun), 
“complement” and “compliment,” “discreet” and “discrete,” “principal” (e.g., “principal investigator”) and 
“principle” (e.g., “principle of measurement”). Do not confuse “imply” and “infer.” 

Prefixes such as “non,” “sub,” “micro,” “multi,” and “"ultra” are not independent words; they should be joined 
to the words they modify, usually without a hyphen. There is no period after the “et” in the abbreviation “et al.” The 
abbreviation “i.e.,” means “that is,” and the abbreviation “e.g.,” means “for example” (these abbreviations are not 
italicized). If desired, more detailed style and formatting instructions can be found in the AIAA style guide, AIAA 
Style (available from AIAA upon request). 

V. Conclusion 
A conclusion section is not required, though it is preferred. Although a conclusion may review the main points of 

the paper, do not replicate the abstract as the conclusion. A conclusion might elaborate on the importance of the 
work or suggest applications and extensions. Note that the conclusion section is the last section of the paper that 
should be numbered. The appendix (if present), acknowledgment, and references should be listed without numbers. 

Appendix 
An appendix, if needed, should appear before the acknowledgements. 

Acknowledgments 
The preferred spelling of the word “acknowledgment” in American English is without the “e” after the “g.” 

Avoid expressions such as “One of us (S.B.A.) would like to thank…” Instead, write “F. A. Author thanks…” 
Sponsor and financial support acknowledgments are also to be listed in the “acknowledgments” section. 
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References 
The following pages are intended to provide examples of the different reference types, as used in the AIAA Style Guide. 

When using the Word version of this template to enter references, select the “references” style from the drop-down style menu to 
automatically format your references. If you are using a print or PDF version of this document, all references should be in 9-point 
font, with reference numbers inserted in superscript immediately before the corresponding reference. You are not required to 
indicate the type of reference; different types are shown here for illustrative purposes only. 

 
 

Periodicals 
1Vatistas, G. H., Lin, S., and Kwok, C. K., “Reverse Flow Radius in Vortex Chambers,” AIAA Journal, Vol. 24, No. 11, 

1986, pp. 1872, 1873. 
2Dornheim, M. A., “Planetary Flight Surge Faces Budget Realities,” Aviation Week and Space Technology, Vol. 145, No. 24, 

9 Dec. 1996, pp. 44-46. 
3Terster, W., “NASA Considers Switch to Delta 2,” Space News, Vol. 8, No. 2, 13-19 Jan. 1997, pp., 1, 18. 
All of the preceding information is required. The journal issue number (“No. 11” in Ref. 1) is preferred, but the month (Nov.) 

can be substituted if the issue number is not available. Use the complete date for daily and weekly publications. Transactions 
follow the same style as other journals; if punctuation is necessary, use a colon to separate the transactions title from the journal 
title. 
 
Books 

4Peyret, R., and Taylor, T. D., Computational Methods in Fluid Flow, 2nd ed., Springer-Verlag, New York, 1983, Chaps. 7, 
14. 

5Oates, G. C. (ed.), Aerothermodynamics of Gas Turbine and Rocket Propulsion, AIAA Education Series, AIAA, New York, 
1984, pp. 19, 136. 

6Volpe, R., “Techniques for Collision Prevention, Impact Stability, and Force Control by Space Manipulators,” Teleoperation 
and Robotics in Space, edited by S. B. Skaar and C. F. Ruoff, Progress in Astronautics and Aeronautics, AIAA, Washington, DC, 
1994, pp. 175-212. 
 

Publisher, place, and date of publication are required for all books. No state or country is required for major cities: New 
York, London, Moscow, etc. A differentiation must always be made between Cambridge, MA, and Cambridge, England, UK. 
Note that series titles are in roman type. 
 
Proceedings 

7Thompson, C. M., “Spacecraft Thermal Control, Design, and Operation,” AIAA Guidance, Navigation, and Control 
Conference, CP849, Vol. 1, AIAA, Washington, DC, 1989, pp. 103-115 

8Chi, Y., (ed.), Fluid Mechanics Proceedings, SP-255, NASA, 1993. 
9Morris, J. D. “Convective Heat Transfer in Radially Rotating Ducts,” Proceedings of the Annual Heat Transfer Conference, 

edited by B. Corbell, Vol. 1, Inst. Of Mechanical Engineering, New York, 1992, pp. 227-234. 
 

At a minimum, proceedings must have the same information as other book references: paper (chapter) and volume title, name 
and location of publisher, editor (if applicable), and pages or chapters cited. Do not include paper numbers in proceedings 
references, and delete the conference location so that it is not confused with the publisher’s location (which is mandatory, except 
for government agencies). Frequently, CP or SP numbers (Conference Proceedings or Symposium Proceedings numbers) are also 
given. These elements are not necessary, but when provided, their places should be as shown in the preceding examples. 
 
Reports, Theses, and Individual Papers 

10Chapman, G. T., and Tobak, M., “Nonlinear Problems in Flight Dynamics,” NASA TM-85940, 1984. 
11Steger, J. L., Jr., Nietubicz, C. J., and Heavey, J. E., “A General Curvilinear Grid Generation Program for Projectile 

Configurations,” U.S. Army Ballistic Research Lab., Rept. ARBRL-MR03142, Aberdeen Proving Ground, MD, Oct. 1981. 
12Tseng, K., “Nonlinear Green’s Function Method for Transonic Potential Flow,” Ph.D. Dissertation, Aeronautics and 

Astronautics Dept., Boston Univ., Cambridge, MA, 1983. 
 

Government agency reports do not require locations. For reports such as NASA TM-85940, neither insert nor delete dashes; 
leave them as provided by the author. Place of publication should be given, although it is not mandatory, for military and 
company reports. Always include a city and state for universities. Papers need only the name of the sponsor; neither the sponsor’s 
location nor the conference name and location are required. Do not confuse proceedings references with conference papers. 
 
Electronic Publications 

CD-ROM publications and regularly issued, dated electronic journals are permitted as references. Archived data sets also 
may be referenced as long as the material is openly accessible and the repository is committed to archiving the data indefinitely. 
References to electronic data available only from personal Web sites or commercial, academic, or government ones where there 
is no commitment to archiving the data are not permitted (see Private Communications and Web sites). 
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13Richard, J. C., and Fralick, G. C., “Use of Drag Probe in Supersonic Flow,” AIAA Meeting Papers on Disc [CD-ROM], 

Vol. 1, No. 2, AIAA, Reston, VA, 1996. 
14Atkins, C. P., and Scantelbury, J. D., “The Activity Coefficient of Sodium Chloride in a Simulated Pore Solution 

Environment,” Journal of Corrosion Science and Engineering [online journal], Vol. 1, No. 1, Paper 2, URL: 
http://www.cp/umist.ac.uk/JCSE/vol1/vol1.html [cited 13 April 1998]. 

15Vickers, A., “10-110 mm/hr Hypodermic Gravity Design A,” Rainfall Simulation Database [online database], URL: 
http://www.geog.le.ac.uk/bgrg/lab.htm [cited 15 March 1998]. 
 

Always include the citation date for online references. Break Web site addresses after punctuation, and do not hyphenate at 
line breaks. 
 
Computer Software 

16TAPP, Thermochemical and Physical Properties, Software Package, Ver. 1.0, E. S. Microware, Hamilton, OH, 1992. 
 

Include a version number and the company name and location of software packages. 
 
Patents 

Patents appear infrequently. Be sure to include the patent number and date. 
17Scherrer, R., Overholster, D., and Watson, K., Lockheed Corp., Burbank, CA, U.S. Patent Application for a “Vehicle,” 

Docket No. P-01-1532, filed 11 Feb. 1979. 
 

Private Communications and Web Sites 
References to private communications and personal Web site addresses are generally not permitted. Private communications 

can be defined as privately held unpublished letters or notes or conversations between an author and one or more individuals. 
They may be cited as references in some case studies, but only with permission of the AIAA staff. Depending on the 
circumstances, private communications and Web site addresses may be incorporated into the main text of a manuscript or may 
appear in footnotes. 

 
Unpublished Papers and Books 

Unpublished works can be used as references as long as they are being considered for publication or can be located by the 
reader (such as papers that are part of an archival collection). If a journal paper or a book is being considered for publication 
choose the format that reflects the status of the work (depending upon whether it has been accepted for publication): 

 
18Doe, J., “Title of Paper,” Conference Name, Publisher’s name and location (submitted for publication) 

19Doe, J., “Title of Paper,” Name of Journal (to be published). 
20Doe, J., “Title of Chapter,” Name of Book, edited by… Publisher’s name and location (to be published). 
21Doe, J., “Title of Work,” Name of Archive, Univ. (or organization) Name, City, State, Year (unpublished). 
 
Unpublished works in an archive must include the name of the archive and the name and location of the university or other 

organization where the archive is held. Also include any cataloging information that may be provided. Always query for an 
update if a work is about to be published. 

http://www.cp/umist.ac.uk/JCSE/vol1/vol1.html�
http://www.geog.le.ac.uk/bgrg/lab.htm�

	Nomenclature
	I. Introduction
	II. Procedure for Paper Submission
	III. General Guidelines
	A. Publication by AIAA
	B. Paper Review and Visa Considerations
	C. Control ID Number vs Paper Number
	D. Copyright
	E. Submission Deadlines
	F. Oversize Papers and Color Illustrations

	IV. Detailed Formatting Instructions
	A. Document Text
	B. Headings
	C. Abstract
	D. Footnotes and References
	E. Images, Figures, and Tables
	F. Equations, Numbers, Symbols, and Abbreviations
	G. General Grammar and Preferred Usage

	V. Conclusion
	Appendix
	Acknowledgments
	References

